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For product information, sales, service, and technical support:

= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.
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Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; c¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category Il IlI, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.
Replace Batteries Properly. Replace batteries only with the specified type and rating.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for details on installing the product so it has
proper ventilation.

RSA6100A Series Quick Start User Manual iii
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General Safety Summary

Terms in this Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product

These terms may appear on the product:

m DANGER indicates an injury hazard immediately accessible as you read the marking.

B WARNING indicates an injury hazard not immediately accessible as you read the marking.
= CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:

A @ +» b

CAUTION Protective Ground .
Refer to Manual (Earth) Terminal Chassis Ground ~ Standby

iv RSA6100A Series Quick Start User Manual
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Compliance Information

Compliance Information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1:2006, EN 61326-2-1:2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 1234

= CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
= |EC 61000-4-2:2001. Electrostatic discharge immunity

B |EC 61000-4-3:2002. RF electromagnetic field immunity 3

= |EC 61000-4-4:2004. Electrical fast transient/burst immunity

B |EC 61000-4-5:2001. Power line surge immunity

® |EC 61000-4-6:2003. Conducted RF immunity ©

E |EC 61000-4-11:2004. Voltage dips and interruptions immunity 7

EN 61000-3-2:2006. AC power line harmonic emissions
EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.

4 Atthe IEC 61000-4-11 Voltage-Interruption Transient Immunity test at 0% for 250 cycles, the EUT reboots and can take greater
than 10 seconds to recover.

5 Performance degradation information for the IEC 61000-4-3 test: Residual spurious signals can typically increase to -55 dBm with
exposure to the disturbance levels of this test.

6  Performance degradation information for the IEC 61000-4-6 test: Residual spurious signals can typically increase to the worse of
either 55 dB below reference level or -75 dBm, with exposure to the disturbance levels of this test.

7 Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels
(IEC 61000-4-11).

RSA6100A Series Quick Start User Manual v
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Compliance Information

Australia / New Zealand Declaration of Conformity - EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

® CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.

Safety Compliance

EC Declaration of Conformity — Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:
Low Voltage Directive 2006/95/EC.

= EN61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
= UL 61010-1:2004, 2nd Edition. Standard for electrical measuring and test equipment.

Canadian Certification

B CAN/CSA-C22.2 No. 61010-1:2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use. Part 1.

Additional Compliances

® |EC 61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type

Test and measuring equipment.

Safety Class

Class 1 - grounded product.

Pollution Degree Description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

= Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

= Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

Vi RSA6100A Series Quick Start User Manual
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Compliance Information

m  Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

B Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Environmental Considerations

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling
Central Web page (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.

RSA6100A Series Quick Start User Manual Vii
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Preface

Preface

This manual describes the installation and basic operation of the RSA6100A Series of real-time spectrum analyzers. For
more detailed information, see the online help for your instrument.

Key Features

The RSAG100A Series is a family of high-performance real-time spectrum analyzers. Key features include:

®m Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault

= DPX Density triggering to easily capture instabilities, transients and hidden signals that are impossible for other signal
analyzers to catch

B Conventional spectrum analysis controls and functions including fast tuning, markers, phase noise, spurious and
other measurements

m Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

= Time domain triggering capability: Runt Triggers, Holdoff Trigger, and Time Qualification to all of the instrument triggers
(Option 200)

B Multi-domain displays that provide an intuitive understanding of time-varying RF signals

®m  Conventional Vector Signal Analysis capability available (Option 21) with modulation analysis for >20 popular modulation
formats

B Seamless capture of signals in up to 110 MHz spans

Documentation

The following documentation is available with your Tektronix RSA6100A Series Spectrum Analyzer. For the most current
documentation, refer to the Tektronix Web site.

To read about Use these documents

Installation and operation RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual.

(overviews) The quick start user manual contains general information about how to put your instrument
into service and guides to user interface controls.

In-depth operation and RSA6100A Series Real-Time Spectrum Analyzers Online help.

user interface help The online help contains detailed information about how to operate the instrument.

Application examples RSA6100A Series Real-Time Spectrum Analyzers Application Examples Manual.

This manual provides practical examples of using the analyzer to accomplish tasks.

Programming commands RSA6100A Series Real-Time Spectrum Analyzers Programmer Manual.

The programming commands for the RSA6100A Series are located in a PDF file located
on the Documents CD.

Specifications and RSA6100A Series Real-Time Spectrum Analyzers Specifications and
performance verification Performance Verification Manual.

This manual contains the instrument specifications and a procedure to check instrument
performance against warranted characteristics. This manual is in a PDF file located
on the Documents CD.

viii
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Preface

To read about Use these documents

User service RSA6100A Series Real-Time Spectrum Analyzers Service Manual.
An optional manual that provides a list of replaceable parts, care and maintenance
information, and information for servicing the instrument to the module level. This manual
is in a PDF file located on the Documents CD.

Software Upgrades

Software upgrades are available. Software upgrades become operational only after you enter a valid option key for the
specific spectrum analyzer model and serial number.

To check for upgrades:
1. Use your Web browser to go to www.tektronix.com/software.

2. Enter the product name (RSA6100A) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

O 00 0C

RSA6100A Series Quick Start User Manual iX
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), declassification and security instructions
(on CD), service manual (on CD), power cord, BNC-N adapter (RSA6106A and RSA6114A only, Tektronix part number
103-0045-XX), Jack-to-Jack SMA adapter (RSA6120A only, Tektronix part number 131-8508-XX) 50 Q SMA terminator
(RSA6120A only, Tektronix part number 015-1022-XX), USB keyboard, USB mouse, and instrument pouch.

Documents

B RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual is available in the following languages:

English, Tektronix part number 071-1909-XX.

Simplified Chinese, Tektronix part number 071-1910-XX.
Japanese, Tektronix part number 071-1911-XX.
Russian, Tektronix part number 071-1912-XX.

B RSA6100A Series Real-Time Spectrum Analyzers Documents CD, Tektronix part number 063-3930-XX.
The Documents CD contains PDF versions of the following manuals:

RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual,
in English, Japanese, Russian and Simplified Chinese.

RSA6100A Series Real-Time Spectrum Analyzers Application Examples Manual,
Tektronix part number 071-2590-XX.

RSA6100A Series Real-Time Spectrum Analyzers Printable Online Help,
Tektronix part number 077-0169-XX.

RSA6100A Series Real-Time Spectrum Analyzers Programmer Manual,
Tektronix part number 077-0249-XX.

RSA6100A Series Real-Time Spectrum Analyzers Service Manual,
Tektronix part number 077-0250-XX.

RSA6100A Series Real-Time Spectrum Analyzers Specifications and Performance Verification Manual,
Tektronix part number 077-0251-XX.

RSA6100A Series Real-Time Spectrum Analyzers Declassification and Security Instructions,
Tektronix part number 077-0170-XX.

RSA6100A Series Quick Start User Manual 1
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Installation

Power Cords

The RSA6100A Series Real-Time Spectrum Analyzers are shipped with one of the following power cord options. Power
cords for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved

by at least one authority acceptable in the country to which the product is shipped.

International Power Plugs

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

A0 - North America power

A1 - Universal EURO power

A2 - United Kingdom power

A3 - Australia power

A4 - 240 V, North America power
A5 - Switzerland power

A6 - Japan power

A10 - China power

A11 - India power

A99 - No power cord

Optional Accessories
B RSA61RHD - Provides an additional removable hard disk drive for use with Option 06

= 065-0765-XX - Additional removable solid-state hard drive for use with Option 08
(Microsoft Windows XP Embedded and instrument SW pre-installed)

2
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Installation

Options
You can add the following options to your spectrum analyzer:
m  QOption 01 - Adds 10 MHz to 3 GHz Pre-Amplifier
= Option 02 - Adds frequency mask triggering and RAM expansion
= Option 05 - Adds digital IQ output and 500 MHz analog IF output
B QOption 06 - Adds a removable hard disk drive (not compatible with Option 07 or Option 08)
= QOption 07 - Adds a DVD+RW drive, no-cost option (not compatible with Option 06 or Option 08)
= Option 08 - Adds a removable solid-state hard drive (not compatible with Option 06 or Option 07)
m  Option 11 - Adds Phase Noise and Jitter Measurement
B QOption 20 - Adds advanced signal analysis (including pulse measurements)
m  QOption 21 - Adds general-purpose digital modulation analysis
= QOption 110 - Adds 110 MHz real-time capture bandwidth
m  Option 200 - Advanced DPX and Triggers
B Qption 1R - Adds Rackmount Kit

Operating Considerations

Power supply requirements

Source voltage and frequency Power consumption
100 — 240 Vgys, 50/60 Hz 450 W maximum (all models)
115 VRMS; 400 Hz

Environmental requirements

Characteristic Description

Operating temperature +5 °C to +50 °C (+5 °C to +40 °C; when accessing the DVD drive or optional
removable hard-disk drive)

Non-operating temperature -20 °C to +60 °C

Humidity 90% at 30 °C (non-condensing)

80% maximum when accessing the DVD drive
Maximum wet-bulb temperature 29 °C

Altitude:
Operating Up to 3000 m (9843 ft)
Non-operating 12190 m (40,000 ft)
Cooling clearance
Bottom 20 mm (0.79 in)
Sides and back 50 mm (1.97 in)
RSAG6100A Series Quick Start User Manual 3
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CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting
on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the spectrum analyzer. The instrument is

somewhat heavy and requires extra care when moving it.

Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with

USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘

network for printing, file sharing, Internet

access, and other functions. Consult your ———

network administrator and use the standard SSiS !

Windows utilities to configure the instrument cacse 23;

for your network. || ||S555. 23 7

Quick Tip

= |f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing

regular approved operating system updates, and using up-to-date antivirus software.

4 RSAB6100A Series Quick Start User Manual
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Powering On the Instrument
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Installation

Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the spectrum analyzer and
the second monitor must have the color set to True Color.

1. Power off the spectrum analyzer and the
external monitor.

2. Connect the external monitor to the
spectrum analyzer.

1/

1909-007

3. Power on the spectrum analyzer and the
external monitor.

o o|o

o olo
| o oo g
' C)C)O
Log 8882° o g
cooco OO

1909-013
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Installation

4. Open the Windows Control Panel. - CER
T

File Edit Wiew Favorites Tools Help

5. Double-click Intel(R) Extreme Graphics -
2 M to open the properties page. Qe - @ (T PO sewen [ Foes [

Address 9 Control Panel

V‘Go

Mame = Comments e |

u’ Control Panel &, accessibilicy Options
& add Hardware
(LyAdd or Remove Pragrams Install or remaove pr

48 Administrative Tools Configure administr
& sutomatic Updates Set up Windows to

Adjust your comput
Installs and trouble

G Switch to Category Yiew

See Also P Date and Time Set the date, time,
‘ windows Lipdete }Display . Changf the app;ar
g | Folder Options Customize the displ
@) Help and support EhFants Add, change, and .
= Game Contraollers Add, remove, and ¢
! reme Graphi J Control the graphic
ﬂlntemet Options Configure your Inte
#mKeyboard Customize your key
':JMouse Cuskomize your mo
N I U S, e LU
i 2.
1909017
6. Click !“teI(R) Dual Display Clone to Intel(R) B2852/82855 GMIGME Graphics Controller Prope... [2][X]
show internal screen (Notebook) content Devis | aor | | | | | |
. . evices | Color | Schemes | Hot Kevs | Rotation | OpenGL | Information
on an external monitor (Monitor).
-~ Settings
'd T
Colors True Caolor -
Manitar
> Screen Area 800 by £00 vl
MNotebook Refresh Rate lm
3-®
Intel(R] Dual
Display Clore:
Extended Deskiop
0k I Cancel Apply
1909018
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Installation

7. Adjust the settings as necessary and Intel(R) B2852/82855 GM/GME Graphics Controller Prope... [2[X]

Devices ]Eolor ] Schemes] Hat Keys] Hotation] DpenGL] Informatinn]
Extended Desktop Settings

then click OK to apply the settings and to
close the properties page.

E

S
I anitar

4

MNotebook

Frimary Device Moteboak ha
- il Secondary Device M anitar >

—

Intel(R] Cual
Display Clone

443

E stended Deskiap Device Settingz...

’_ UK | Cancel Apply

1909019
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Adjusting the Windows Display Settings

Installation

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.

1. Open the Windows Control Panel.

2. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

3. Adjust the settings as necessary.

NOTE. Not all of the selections in the
property page will be available if there is no
external monitor connected to the instrument.

4. Click OK to apply the settings and to
close the properties page.

#- Control Panel
Edit

File Tools

@ Back ~ J

View Favorites Help

\’ /rj Search U Folders v };f

?lt

Address | Control Panel

v .Go

Name -~
Qs Accessibility Options
% Add Hardware
{2 Add or Remove Programs
4@ Administrative Tools
“ Automatic Updates
< Date and Time

“ Windows Update 3\0'5')'“ )
| Folder Options

Q) Help and Support SFonts

& Game Controllers

T Intel(R) Extreme Graphics 2 M
antemet ptions
.&Keyboard

) Mouse

[T

u" Control Panel 2

Gr Switch ko Category Wiew

See Also

Comments o
Adjust your comput
Installs and trouble
Install or remove pt
Configure administr
Set up Windows to
Set the date, time,
Change the appear
Customize the displ
Add, change, and .
Add, remove, and ¢
Control the graphic
Configure your Inte
Customize your key
Customize your mo

Frmmeebe b b

Intel(R) 82852/82855 GM/GME Graphics Controller Prope... [2)[X]

Devices ]Color I Schemes' Hat Keysl Hotationl UpenGLl Infalmation]

' - Settings
'd T E—
= Colors True Color -
Manitor
' Screen Area 800 by 600 -
Notebook Refresh Rate 60 Hz -
e
Intel(R) Dual
Display Clone
44
Estended Desktop

r% oK I Cancel Apply

1909-111

1909-110

NOTE. Although it is not recommended, you can attach a second monitor after the spectrum analyzer is powered on;
however, after connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control

panel.
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Installation

Inspecting the Instrument

Launch the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA6100A Series Real-Time
Spectrum Analyzers Specifications and Performance Verification Technical Reference manual PDF (Tektronix part number
077-0251-XX) located on the Documents CD.

1.

Select Tools > Diagnostics.

On the Diagnostics tab, click All
Modules, All Tests.

Click Single Test.

Click RUN.

The instrument will run through
the tests one at a time. A check
mark or X icon will appear to the
right of each check box as that
test is completed. The check icon
means the test was passed. The
X means the test was failed.

For tests that require manual
intervention, follow the on-screen
instructions to complete the tests.

3 search...

Tools

Alignments...

| Diagnostics

Install Upgrades. ..

Options

-@

71 Tek RSA61004 - [Diagnostics]

1903020

= [ AllModules, &ll Tests
&

Dlaaﬂﬂstlts&p_zgm Self Tests

[0  Hardware Init
# [ ] Digital Board
oAl e Current Series
# [ ] Reference Cscillator
@ [ Frstlo Bl
®[] First Converter Date: 7/30/2007
# [] Second Converter Time: 7.56 PM
® [ ThirdF )
®[]  Marrow Band Acquisition Board Terp: 30.5'C
@[] Wide Band Acquisition Board Repeat
# [ ] DPSABoard N
w [] o Output Board CTimes: [0 ks
®[]  Attenuator
@[] Signal Path Ountil Fail
® Front Panel

a O continuous

@ Single Test

TestPragress
Diagnostics Failure Info

Exit Diagnostics

1900-021

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (a subset of the Administrative tools in the Windows Control Panel) to view failure history and nondiagnostic failures
reported by the application.

10
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Installation

User Maintenance

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

/ ' \ cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software

Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument
If you return your instrument to Tektronix:
E  Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

= When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

= Seal the shipping carton with an industrial stapler or strapping tape.

RSA6100A Series Quick Start User Manual 11
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

@eee ©® ©

[ Displays)

Settings

Trigger

Acquire

HIU
SN0

Analysis

l

Freq

g

Spectrum
Span

Ampl

B

@eee

1909-001

Operation

Ref number Item Description Menu equivalent
1 Media DVD£RW drive, removable hard disk drive, or removable
solid-state hard drive.
2 Displays Opens the Displays dialog box to select measurement Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected display. Setup > Settings
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab 2
8 Span (Spectrum) Adjusts the span or frequency range shown in the Spectrum Setup > Settings >
display. 1 Freq & Span! 2
9 Amplitude Adjusts the reference level. Setup >
Amplitude 2

RSAB6100A Series Quick Start User Manual
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Operation

Ref number Item Description Menu equivalent
10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup > Settings >
BWtab1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

o
e @

Markers
Peak

) e

@ee®

800

Select
Yy
Define < o
D
Ref number Item Description Menu equivalent
11 Tab Moves the cursor to the next entry in the dialog box or
control panel. Same as pressing the Tab key on an external
keyboard.
12 Run (Stop) Push to start and stop acquisitions. Run > Run
13 Markers, Peak Moves the active marker to the maximum peak of the trace

in the selected display. If markers are turned off, the MR
(marker reference) marker will appear at the maximum peak.

14 Markers, Select Selects the next marker.

15 Markers, Define Opens the Markers control panel.

16 Esc Exits dialog boxes without saving changes.

17 Control knob Changes values in numeric and list controls. Pressing the
knob (clicking it) is the same as pressing the Enter key on
a keyboard.

18 Arrow keys Move the Markers. The Up arrow moves the selected

marker 10 trace points to the right. The down arrow moves
the selected marker 10 trace points to the left. The left and
right arrows move the selected marker to the next peak.
(Turning the knob moves the marker one trace point left or
right.)

14 RSA6100A Series Quick Start User Manual
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D @ @ @D
D ® & @D
D @D @ @
@ O G () (e

x1/dBx " Enter
(o) (=

Operation

N
Ref number Item Description Menu equivalent
19 Keypad Enters values in controls.
20 Enter Completes the data entry in controls. Same as pressing the
Enter key on the keyboard.
@ Recall ) ( Help @
]
@ o G @)
Touch Screen |1
@) o) C=2(20)
Ref number Item Description Menu equivalent
21 Recall Opens the Recall dialog box. File > Recall...
22 Save Saves working file using the same user selections as for the File > Save
previous Save action.
23 Touch Screen Turns the touch screen on and off.
On/Off
24 Help Displays the online help. Help >
User Manual
25 Print Opens the Print dialog box. Printouts are a screen capture File > Print
of the RSAG100A application window.
26 Preset Returns the instrument to its default or preset values. After Setup > Preset

a Preset action, the Spectrum Analyzer display is the only
open window.

RSAB6100A Series Quick Start User Manual
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Operation

Front Panel Connectors

(

q ! ) | ]
[ (@n] [an]
O OO
o OO
O OO
O O o o
SS38° o o
oo oO o O
ocoocoo O O
( Gl
[ e i@ | o
Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High > 2.0V, Low < 0.4V, (output current 1 mA)
2 Trig In External Trigger input connector, —2.5 V to +2.5 V range,
trigger level is user adjustable
3 USB 1.1 USB 1.1 mouse connector
4 USB 2.0 USB 2.0 connector
5 RF Input RF input connector 50 Q

16
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Rear Panel

Operation

@ ©0 6

2

@

&

°
©)

oo@o@@o@ o @

OROOO® o
i

1909-011

Ref number Connector, Description
1 AC Input, main power connector
2 GPIB
3 IF output (Option 05)
4,5 Real Time 1Q Out (Option 05)
6 Ref In, reference frequency input
7 Ref Out, reference frequency output
8 Headphone, audio output connector
9 External Trigger 2 Input
10 COM 2, serial port for connecting peripherals
1 VGA, external monitor output (resolution not limited to VGA)
12 PS2 Keyboard input
13 USB?2 ports for mouse and other USB2 devices
14 TekLink, reserved for future use
15 +28 VDC Output, (switched)
16 LAN, Ethernet network connector
RSAG6100A Series Quick Start User Manual 17
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Operation

Interface and Display Elements

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.

OO000606 & () (9 (1)

) rgersastoy -opXppectrg J /. } ] | | EI¥K

Gle  Miew | Run Markers  (Setup | Tools | Window  Help = 5 X

“T_Bplay?l Mkea[gtma[_ngﬂ[_ccﬂ[_nﬂ “ Freq: 91.49 MHz “ ReflLev: -50.00 dBm | Ampl [ Run

< w Bitmap  [¥]Show  On

o .50.02 dBemn

o dBefdiv:
4,20 dB @
=
100 kHr
o200dEm 0 ‘ s ik » : 1 ‘ 1
o CF: 01,49 MHz o Span: 9.67 MHz

Analyzing Acg By 10,00 MHz, Acg Length: 89,120 us Real Time | Free Run Ref: Int  Atten: 10 dB

Ref number Item Description

1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.

Markers Opens or closes the Marker toolbar at the bottom of the window.
Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.
Trigger Opens the Trigger control panel so that you can define the trigger settings.
Acquire Opens the Acquire control panel so that you can define the acquisition settings.
Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.

7 Center Frequency Displays the Center Frequency. To change the value, click the text and use the
front panel knob to dial in a frequency. You can also enter a frequency with the
front panel keypad or use the front panel up and down buttons.

18 RSAG6100A Series Quick Start User Manual
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Operation

Ref number Item Description

8 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.

10 Replay Runs a new measurement cycle on the existing acquisition data record using
any new settings.

" Run Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.
You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

12 Check Mark indicator

The check mark indicator ('f ) in the upper, left-hand corner of the display
indicates the display for which the acquisition hardware is optimized.

RSA6100A Series Quick Start User Manual
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Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

() ©

NS

m File  Wiews | Run  Markers Setup  Tools  Wirdow  Help - 2 X
Displays @Q[Settings” Trig ” Ao ” Ana ] % Freq: 91.49 MHz “ RefLey: -50.00 dBm
Ve v Bitmap [¥]Show  On Clear
< -50.00 demn
Z defdiv:

6.00 dB
©RBEW

100 kHz

110,00 cBm [ s

¢ CF: 91,48 MHz & Span; 9.67 MHz

1909023

Table 1: Common icons

Ref number Control icon Description
1 s Drop-down List. Click to select a value from the drop-down list.
2 ] Knob. Click anywhere on the icon or on the text readout to select the control. You

can then change the value with the front panel control knob or arrow keys, or enter a
value from the keypad.

3 6.337us Italicized numbers. These indicate automatically selected control values. Several
controls in the instrument (for example, RBW and Analysis Length) allow you to
select an Auto mode. In Auto mode, the instrument software automatically sets the
value. You can change the control to Manual mode by changing the value. To return
to Auto mode, clear the value, and then press the Enter key.

20 RSA6100A Series Quick Start User Manual
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Basic Concepts

Real Time Spectrum Analyzers

Tektronix Real-Time spectrum analyzers, such as the RSA6100A Series Spectrum Analyzers, have an optional, exclusive
frequency mask trigger. The frequency mask trigger allows you to set up a spectral mask to capture a signal when a spectral
anomaly occurs. This allows the real time spectrum analyzer to check 100% of the input signal before acquiring, and

then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events. Option 200 includes the ability to measure and trigger on signal density values in the
DPX display.

The RSA6100A Series Spectrum Analyzers allow you to view the captured signals in a wide variety of time-correlated
displays. This is useful for device troubleshooting and signal characterization applications. All of the measurements are
based on the same underlying set of time domain sample data.

Measurement Displays

The RSA6100A window can show one or any combination of general purpose and application-specific displays.

This example shows a single DPX Spectrum 1 Tek RSAG100A - [DPX Spectrum] EEE
dISp|ay W|th|n the WmeW B Fi=  iew Run  Markers Setup  Took  Window  Help -
© Freq: 91.40 MHz  RefLev: -50.00 dBm R Run
< v Bitmap  [Fshow  on

& 50,00 dBrm

< dBfdiv:
6.00 dB

= RBW
100 fHz

[ a ! ] | |
| - | i ¥ |
| | ) ! Lad B ,
! 1 A -
e b W' Nl Wi W
- bl d " 5 'h.'{ - ¥
-110.00 dEm M i T A ¥ i ’ e b/ .
o CF: 91.49 MHz © Span: 9.67 MHz

1909024
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This example shows the window with two [ TekRss 100 BEE

diSplayS, a Spectrum dISpIay and a DPX Fle  ¥iew Run  Markers  Setup  Tools  Window  Help

spectrum dlsplay [Dispiays | MMEEE © Freq: 9149 MHz 2 Reflev: -50.00 dBm
. . m [\ Spectrum @

When yOU have more than one dISp|ay ~ Bitmap [Show On < v Trace 1 [lShow  +Peak Normal

open, the display with the check mark icon = Gt : = oo

has control over the acquisition hardware. i , o

To give a display priority over any others, e _ ‘ - ‘

click its title bar.

‘ | ‘ \
\“ﬂ" ‘“Ml "”'”w LLW]H

-110,00 dBm il Y || -is0.00 dem
Autoscale o CF 91,49 MHz < Span: 9.67 MHz Autoscale % CF: 91,49 MHz ¥ Span: 9.67 MHz

Markers v MR [Frequency 91485487 MHe reak | [¢] [*] [+] x]
Snalyzing Acg BY: 10,00 MHz, Acq Length: 89,120 us Real Time  Free Run Ref: Int  Atten: 10 dB Preamp
1909-025
This example shows four displays in the I Tek RSAG100A AEE
W|ndOW Fle Visw Run  Markers Setup  Tooks  Window  Help
|m Markers ||Settings || Trig || Acg || Ana | © Freq: 91.49 MHz % RefLev: -50.00 dBm
'!1! Time Overview
¥ Eitmap  Mshow  on (A= [T (#2600 es Actual: 44,560 Us
& 50,00 dem -
9 -50.00 dem I
& dBfdiv: |
6.00dB = obfdiv: (
10.0 dé
~ RBW
100 kHz
oo WY 11 -150.00 dBm -
Autoscals | 2 CF: 9149 MHz Autoscals o Position: 0,000 5 % Scale: 89,120 us
b ¥ [ Trace o Mormal v Trace 1 [show  +Peak Normal
& 1.09 m < -50.00 dBm
< dfdiv:
\n ﬂ;r 1 H M "W .N %
© Pasitian: R \‘ u | I‘ “ | ‘
sHBi [ J || i 50 ke || |l Ul ‘ J‘ W
Al
w il i
831 UV
@ Pasition: 0,000 5 o Scale; 94,560 us -150.00 dBm
Max: 943.6 UV @ 13.54us  Min-232.4 U @ 39.19us © (F: 91,40 MHz & Span: 5,67 MHz
1909-06

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.

22 RSA6100A Series Quick Start User Manual
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Navigating Displays

The RSAG100A uses multiple displays to keep operations simple, and yet provide advanced functionality when needed.
Some of the display categories include:

General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

Analog Modulation. These displays show graphs and measurements for Analog Modulation, Frequency Modulation,
and Phase Modulation.

General Purpose Digital Modulation displays. Available with Option 21, General Purpose Modulation Analysis.
These displays show the results of demodulating signals and analyzing them in multiple domains. Examples of these
displays include: Constellation, EVM vs Time, Eye, Symbol Table, and Trellis diagrams.

RF Measurements displays. These displays show the results of automated measurements on RF signals. Examples
of these displays include: ACPR, MCPR, and CCDF.

Pulsed RF displays. Available with Option 20, Advanced Signal Analysis. These displays show the results of advanced
analysis for pulsed RF signals. Examples of these displays include: Pulse Statistics, Pulse Table, and Pulse Trace.

RSA6100A Series Quick Start User Manual
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Selecting Displays
The spectrum analyzer provides an easy way of selecting displays.

1. Click Displays to open the Select I Tek RSA6100A - [Spectrum]
DISp|ayS dla|Og bOX File Wiew Run  Markers Sstup  Tools  Window  Help -8 x
| Displays | | Markers ||Settings WWW 2 Freq: 91.49 MHz = Reflev: -50.00 dBm

1909027

There are two ways to select displays: choose any combination of displays or use an Application Preset.

Choose any Combination of Displays. Select displays one by one as needed.

1. Click the desired application folder
in the Select Displays dialog box.

The available displays for each G Ty I T °'“5“”“°"‘@'959“

folder are listed in the Available
Displays pane.

I Select Displays

Folders: Available displays:
General Signal Viewing .

Analog Modulation

. . . GP Digital Modulation y -
2. Click one of the display icons. RF Measurements ampicude vs |G Frequency  Phase vs
Pulsed RF Time Spectrum vs Time Time

3. Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.

[ I

RF 1&Q vs Spectrogram Time
Time Overview

Repeat the procedure to add other gelesodidolays:
displays. Adc
Spectrum
4, Click OK to close the dialog box. ’ @

The selected displays will open.

(5] (o=

1909140
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Use an Application Preset. Select displays from the presets for your application.

1. Click Application Presets... in the
Select Displays dialog box

I\ Select Displays

Choose any combination below, or use an Application Preset, Application Presets... .——‘

Folders: Available displays:

Anzlog Modulation

GP Digital Modulation

RF Measurerments Ampltude vs Frequency  Phasevs  RFI&Qvs
Pulsed RF Time vs Time Time Time

0 ®

Spectrogram Time
Overview

1900-141

3. Click OK to close the dialog box. The
preset displays will open. (See Table 2.)

Pulse Analysis
Spectrum Analysis (0.1 - 14 GHz)
Spectrum Analysis (0.1 - 20 GHz)

Spectrum Analysis (0.1 - 6.2 GHz)
Spur Search Multi Zone 9k-1GHz

Time-Frequency Analysis

C:}K ] [ Cancel

Table 2: Application presets

Presets Displays

Modulation Analysis (Option 21 only) Constellation, DPX Spectrum, Signal Quality, Symbol Table

Pulse Analysis (Option 20 only) DPX Spectrum, Pulse Table, Pulse Trace, Time Overview

Spectrum Analysis (0.1 - 20 GHz, 0.1 - 14 GHz, or Spectrum (center frequency of 10.5 GHz, 7.05 GHz or 3.15 GHz)

0.1-6.2 GHz)

Spur Search Multi Zone 9k-1GHz Spurious

Time-Frequency Analysis Frequency vs Time, Spectrogram, Spectrum, Time Overview
RSAG6100A Series Quick Start User Manual 25
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Quick Tips
m  Push the Displays button on the front panel to open the Select Displays dialog box.
B To add a display, double-click the icon.
= To remove displays, do one of the following:
= Select a display icon in the Selected Displays list, and then click Remove.
= Double-click a display icon in the Selected Displays list.
= Click the Close button in the upper right hand corner of the selected display.

®E  You can mix displays from multiple application folders.

Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 3: Common information messages

Message Explanation and recommended action

Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

= Adisplay other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.
Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

® The data is from a recalled file.
There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.
Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.
Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.
RBW increased to 100 kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.

26 RSA6100A Series Quick Start User Manual
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Changing Measurement Settings

Operation

The displays have settings that control how signals are acquired and processed. The settings that you can change depend

on the selected display.

To access the settings (in this case, for the Spectrum display):

1. Click Settings to open the Settings
control panel.

2. Adjust the controls as needed for your
signal or test. For example, use the
Freq & Span tab to set frequency and
span. Most of the control panels have
tabs that provide easy access to other
related controls.

3. You can change the appearance of the
display screen in the Prefs tab. Not all
of the following controls apply to every
display. Some displays have additional
controls not described here.

= To turn on or off the graticule, select
the Show graticule check box.

®  To turn on or off the marker readout,
select the Show Marker readout in
graph check box.

= To turn on or off the trace legend,
select the Show trace legend check
box.

Quick Tip

1. Tek RSA610DA - [Spectrum] =)=
Bl Fi=  view Run Markers Sehup  Tools  Window  Help -8 x
|D\splays Warkers |(Settings |[ Trig || Acg |[ Ara | = Freg: 91.49 MHz 2 Reflev: -50.00 dBm (Run]]
1909029
Spectrum Freq & Span (8w | Traces| S | Prefs
Settings S 7
Center:12.44140 GHz | Span{40.00 Mz
Start:12.42140 GHz |
Stop:12.46140 GHz |
Bostors Step Size: 2.0000 MH:
b sesl2000 | B
1908-080

File View Fun Markers Setup Tooks Window Help -8 x

“ Freq: 1.50000 GHz = RefLev: 0.00 dBm Run
¥ v Trace2 [ZShow Average Max 10

© 0.00 dBm
© dBjdiv:
10.0de
< RBW:
300 kHz
[ vew:

W w L"U“

uncalibrated instrument

-100.00 dBm

© CF: 1,50000 GHe

© Span: 40.00 MHz

o

Spectrum Freq & Span | BW | Traces | Scale | Prefs €
Settings ‘
Show: |Center, Span v | Trace points:  |801 v
[“]Show graticule [“]Show Marker readout in graph (selected marker)
[“]Shaw trace legend DMavkEr Noise mode (Requires dBm Ampl units and
Average trace detect)
Defaults

ez ) (0 ) B @) ) (1]

Ref: Int | Atten: 25 dB

Frequency |15 GHz

Markers v MR

Simulated data SIM_NB.igt, SIM_WB.igt

Stopped Real Time Free Run

1909-143

B [f you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control

panel for that display.
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1.

To start with the default instrument
settings, push the Preset button on the
front panel or select Preset from the
Setup menu.

Quick Tip

B Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.
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Connecting a Signal

The spectrum analyzer has a single RF signal input located on the front panel. Make sure that you observe the input
signal requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any

A electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables aftached to the instrument with
the other ends of the cables open.

Required Signal Levels

The following table shows the input signal levels over which the Real Time Spectrum Analyzer can be used for
measurements. The accuracy is guaranteed at a signal amplitude and frequency (normalization point). Measurements can
be made on signals within the entire range of allowable inputs, but the accuracy of the measurement is affected by the
frequency and amplitude of the signal to be measured (see the RSA6100A data sheet for more information).

RF signal input range (CW or peak envelope power)

Modulation measurement requirement Spectral display requirement
-50 dBm to +30 dBm DANL to +30 dBm

Input signal requirements

Characteristic Description
Input impedance 50 Q
Input frequency range
RSA6106A 9 kHz t0 6.2 GHz
RSA6114A 9 kHz to 14 GHz
RSA6120A 9 kHz to 20 GHz
Maximum measurable continuous input power 1 W (+30 dBm)
Maximum voltage rating 140 V DC, AC coupled

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). The maximum
Z l \ voltage rating is +40 V DC. The maximum pulse specifications are 75 W peak, 10 us pulse width, 0.001 duty cycle, and
230 dB attenuation.
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To connect an RF signal:

1. Connect the signal to the RF INPUT
connector on the front panel.

[enlen}anlenfan]
cooco O O

L]
@ 1909015

Quick Tip

®  |f the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator
output to the RF Input connector.

Starting and Stopping Acquisitions

1. Click the Run button to start an L Tek RSA61004 - [Spectrum] BEE

aCC]UISItIOI‘l Fie Miew Run  Markers Setup  Tools  Window  Help
Whil iring data. the butt I % Freq: 91.49 MHz % Reflev: -50.00 dBm Revizy | [ R
lle acquiring data, the button i

label has green lettering.

2. Click the Run button again to stop
an acquisition. If an analysis is in

. o . I\ Tek RSA610DA - [Spectrum] @@@
process, it will finish its sequence FR MR R s e Tols) S 5 x
and then stop. The button label | [Dssre] ¢ Freq: o149 Mz > RefLev: -50.00 dom [evi ) o)
changes from green lettering to e

black lettering to indicate that the

instrument has stopped.

Quick Tip

= Push the front panel Run button to start and stop acquisitions.

Run Control

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to

the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.
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Markers

Operation

Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure

the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.

1. Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

2. Select Add Marker from the
drop-down list on the Marker
Toolbar.

The first marker is designated
the marker reference (MR).

3. Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

4. Read the frequency and power
level from the marker readout on
the display.
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I\ Tek RSA61004 - [Spectrum] CEX]
Fie Wiew Run  Markers Setup  Tools  Window  Help .8 x
| Displays | [Markers |[Settings o Freq: 91.49 MHz © RefLev: -50.00 dBm 3
1908032
Define Marker Properties | Dafine Pasks
Markers =
Referance Delta Markers
Add Marker: 4 M1 M2 M3 M4
Attach to:
(in selected
display) 4
Readouts: |Delta ¥
Add Marker
Delete Marker
i Mmrraott ook =
Analyzing Acg BW/: 40.00 MHz, Acg Length: 4.440 us Real Time | Free Run Ref: Int | Atten: 15 dB
1909033
|\ Tek RSAG100A - [Spectrum] [BEE
BN rie  view Nkers  Setup  Tools  Window  Help .8 x
‘ Displays m /ég]mﬂﬁ Y Freq: 91.49 MHz ~ ReflLev: -50.00 dBm Run
# Trac 1 [Flshow  +Paak Mormal
© -50,00 dBm
< deyfdiv:
10,0 di
© RBW
50 ke
|| \ f ‘ ‘ ‘
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-150.00 dBm
& (F; 91,40 MHz % Span;: 9.67 MHz

Markers v MR

Frequency v |EBEGIE:

e ) H B EE ) O

1908034
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Markers Display

®m Rectangular markers show absolute values in the readout. The readout of the selected marker appears in the upper left
corner of the display and in the Marker toolbar.

= Diamond markers show delta values (relative to the reference marker). The delta readout of the selected marker appears
in the upper right corner of the display and in the Marker toolbar.

= When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

B When you attach the marker to the bitmap trace in the DPX spectrum display, the marker readout indicates the hit count
for pixels (maximum 65,536) along with frequency and power (see the following figure). You can position the marker
at any point in the graph.

m |f Option 200 is installed, markers attached to the DPX bitmap display the signal density in percent at the selected pixel,
rather then the hit count.

")\ Tek RSAG100A — [DPX Spectrum]

File Wiew PRun Markers Setup Toolz Window Help

‘[Displays ] [Markers ][Settings” Trig ” Acq " Ana ] © Freq: 1.50C

< v +Peak Tr [YShow +Pk Mormal
& 0.00 dem \

o dBfdiv:
10.0 de

o RBW:
400 #Hz

Quick Tips

B |f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

= Click Table in the Marker toolbar to open a tabular display showing the marker information.
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 4.) Some of these controls are similar to those
on the front panel.

Table 4: Marker toolbar

Description

Opens the Define Markers control panel. Use the control panel to add and remove markers and

Define
to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the selected marker. This

To Center
button is only present when the selected display has frequency on the horizontal axis.

Moves the marker to the maximum peak level on the trace. The maximum peak can be either the
highest or the lowest point in displays with both positive and negative values on their vertical axis
(such as Frequency Error or Phase).

Peak

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-lower-amplitude density peak at the same frequency.

Moves the selected marker to the next higher peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-higher-amplitude density peak at the same frequency.

Table Opens or closes the marker table in the display.

I B |®|E III_

Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.

RSA6100A Series Quick Start User Manual 33
www.valuetronics.com



Operation

Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers | Markers [Dos | v ML [Femueny V[0 ola (x] |
control panel. g~
USG the Contr0| panel tO azii::rs Marker Properties | Define Peaks
Reference Dielta Markers
H  Add or delete markers. oo e - e e "
Attach to: Tracel ¥ Tracel %
®  Turn markers off. o
Readouts: |Delta hd
u Assign markers to specific traces. R oMl [Frequency (W20 M olola ]
1909-03¢
®m  Set the marker readouts to absolute or
delta.

m  Define the threshold and excursion
values.

Quick Tip

B You can add or delete markers from the drop-down list next to Define in the Marker toolbar.

Touchscreen Actions

You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Some selections in the Touchscreen Actions IE P
!

menu are selectable only when a marker is
defined.

Span Zoom
+ CFPan

# 1 Zoom

& pan

Reset scale

Marker to peak
MNext peak 3

Add marker
Delete marker

All markers off

Trigger On This

Touchscreen Actions menu
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Table 5: Touchscreen actions menu

Icon

Menu item

Operation

Description

Select

Selects markers and adjusts their position.

Span Zoom

Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.

Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan

Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings to their default
values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Positions the DPX Density measurement box at the click point, measures the
current signal density, sets up the DPX Density Trigger function based on the
measurement result, and starts acquisitions.
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1. Push the Print button on the front panel W

or select Print from the File menu. & Recal... ctrl+0
& save Ctrl+s
Save As...

Data properties...

& Print... Ctrl+P @

Print Preview

) Preset
Application Presets. ..

Exit
1909067

2. Fill out the details in the Print dialog box, - PX

and then click OK. =
The Print dialog box is the standard Name: [ v
Microsoft Windows Print dialog box. The Status Ready
printer Contr0|s are dependent on your Type: Microsoft Office Document Image ‘witer Diriver
. ‘Where:  Microsoft Document Imaging 'iter Port:
printer.
Comment: [ Pit ta file:
Frint range Copies
®al Nurmber of copies: 1 £
o e e ] Clo
() Selection
1909038
Ink Saver Mode
You can print screen images with a white background.
1. Select Options from the Tools menu. Tools | Window  Help
¥ Search.
Alignments...
Dizgnostics
Ihstall Uperades...
L Optiohs o—:—-.
1909-145
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2. Select the Colors tab in the control panel.

3. Set the Color Scheme to Blizzard.

The background color changes from
black to white in the graphs.
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1 Tek RSA61004 ~ [Spectrum] [M=1[3)
[ File View Run Markers Setup Tools Window Help -8 x
[Markers |(settings][ Trig J(aca J(ana | = Frea: 1.50000 GHe o RefLev: 0.00 dBm
v v Trace 1 [¥IShow +Paak Narmal
© 0,00 dBm
© dBfdiv:

100d8
o RBW:

200 k42
CJvew:

-100.00 dBm Data from uncalibrated instrumert

< Span; 40.00 MHz

© CF: 1.50000 GHz

Options | Save and Export | GPIB | Security | Colors | @

Stopped Simulated data SIM_NB.igt, SIM_WE.igt Real Time  Free Run Ref: Int  Atten: 25 dB

1909-146
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Saving Data

You can save different types of data for future use.

1. Select Save As. . . from the File menu Fie |

to open the Save As dialog box. & rel... crl+a
& save ctrl+s
| Save As... ! @
Data properties... %_‘
&h Print... Ctrl+P
Print Preview
3 Preset
Application Presets. ..
Exit
1909033
2. Navigate to the folder where you want Savds e 2% |
to save the setups, or use the default Savein | 3 RGAGTOUA Fies ¥ o3> m
location. ) (5 5ample Data Records
2 2
. My Recent
3. Enter a file name. Dw‘
4. Select the type of file to save. (See Dssklon
Table 6.
) -7
. My Documents
5. Click Save. ) @ @ @
59
My Computer
(,’] Fil rianes |Stabe Setup 1031-06 Setup : v Save
MyNe'Juyk Saveastype: | Setupfiles > Cancel

1909-040

Table 6: File types for save

File types Description

Setup files Saves all of the setup information for all settings displays, except those settings that
are specified under the Tools menu (Alignments and Options) or in the Config In/Out
control panel.

Results Export files Saves the trace and numeric data for the selected display. The trace and numeric data
are saved in CSV format as text files.

Picture (PNG/JPG/BMP) Saves a graphical representation of the screen in the specified format. This option is
useful for including the graphic in reports or other applications. Marker readouts and
other information are included.

Selected Trace Saves a trace for later recall back into the display from which it was saved.
Data (acquisition data and Saves data for reanalysis by the RSA6100A Series Real-Time Spectrum Analyzers or as
acquisition data export) CSV (comma-separated value) data to use with external software.
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Quick Tips

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

m  Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.

Recalling Data

You can recall acquisition data and setup files previously saved by the RSA6100A Series Real-Time Spectrum Analyzers.

1. Push the Recall button on the front panel e

or select Recall from the File menu. [ Recl.. N coli0 ol @
EH save " crlss

Save As...

Data properties...

&h Print... Ctrl+P
Print Preview
= Preset
Application Presets, ..
Exit
1909-041
2. In the Open dialog box, browse to the
location of the file.
Open @@
3. Ifyou do not see the file, select the type ookt | £ ASAGTOOA Fies ERE
of file under Files of Type. D [Bries...
My Recent
4. Double click the file name to load the file. DUI
> | @
My Documents
9
My Computer
« ) File name: . v Open
MyNewok | Flesoltps: | Seupfies v
1909-042
Quick Tip

If you recall a trace that has an x-axis range that does not fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.
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Advanced Techniques

This section contains advanced operating techniques. For examples of practical applications, see the RSA6100A Series
Real-Time Spectrum Analyzers Application Examples Manual.

Setting Up Triggering

The RSA6100A Series Real-Time Spectrum Analyzer offers real-time frequency domain triggering (option 02) in addition to
power-level triggers, line trigger, and external triggers. It uses a trigger event as a reference point in time for the seamless
acquisition of the signal. This allows the spectrum analyzer to store both pretrigger and post-trigger information.

The spectrum analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:

= RF Input

m Trig In

B Trig 2 In

B Gated

E line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input

as the trigger source, you can chose from two trigger types:

DPX Density Triggering. This trigger type enables the instrument to capture any signal you can see in the DPX display,
including difficult to see signals hiding beneath other signals that have a higher amplitude or a greater repetition rate. Using
the Trigger On This™ feature, you can draw a box around the area of interest in the graph, set a Density threshold, and
the instrument will trigger when the measured Density exceeds your threshold.

Time Qualified Triggering. Time Qualified triggers allow you to trigger the instrument based on when signal transitions
occur in time. You can apply time qualification to the basic trigger types. For example, if you select the Power type and
configure it to trigger on a rising edge, Time Qualification allows you to screen rising-edge events based on how long the
signal stays high after it exceeds the trigger threshold. You may wish to trigger only on pulses that last longer than a
specified time or shorter than a specified time. You can set Time Qualified to accept only pulse widths between two specified
values, or outside of these two values.

You can also time qualify Frequency Mask, DPX Density, and Runt trigger events. For each trigger type, the instrument finds
all events that meet the basic trigger criteria, then further tests them against your time qualification parameters.

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.
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Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

m Position and Delay parameters that define where a trigger occurs within the acquired data record and whether to
delay the trigger for a set amount of time.

= Whether a single event can trigger an entire sweep, or each segment of the sweep requires a new trigger event in
swept acquisition mode.
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Accessing Trigger Parameters

1. Click Trig to open the Trigger control 1) Tek RSA6100A - [Spectrum] EEE
panel. File View Run Markers Setup Tooks  ‘Window  Help -8 x

| Trig © Freq: 91.40 MHz © RefLev: -50.00 dBm Repla

1909.043

2. As shown in the following steps, click
one of the tabs in the Trigger control @
panel to define the trigger parameters.

Trigger Event | & Time Qualfied | Advanced
3. Use the Event tab to set parameters that ®Free Run e 5‘®”R Level: [10.0 cBm
. . Inpuf hd ise N
define trigger events. The parameters o -
. ., rggere Type: [ Time-domain BW:
vary depending on the trigger Source oo 5] OFl pcnzt 40.00 bz
and Type selections. :
1908044
4. Use the Time Qualified tab to set
parameters that qualify trigger events
based on their time duration. : e
Trigger | Event| ® Time Qualfied | Advanced
® Free Run @ None

Time 1: |10.000 us

o e oves [t ‘
: © Longer O Outside fgl
1908045
5. Use the Advanced tab to select whether

to trigger on each segment while in @
Swept acquisition mode and to.s.,et _— T o
parameters that control the position of
the trigger event. e . C)voldoft: [15

O Triggered

bebr: 0% [ Trigger each segment of Swept acquisitions

requires trigger signals across entire Spar

1908046

Quick Tip
B QOther ways to access the Trigger control panel:
= Push the Trigger button on the front panel.

= Select Trigger . . . from the Setup menu.

Setting Up a DPX Density Trigger

The DPX Density trigger captures transients partially obscured by other higher-amplitude or more frequent signals. If you
can see it in the DPX bitmap, you can trigger on it. The DPX Density area measurement is used to select the region of
interest in the display and to measure its current density. You set a density threshold, and the instrument triggers when the
density measurement exceeds your threshold.
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The quickest way to set up a DPX Density trigger is to use a mouse and right-click on a signal of interest in the DPX
graph, or press on the screen and hold with your finger for one second. A menu will pop up. Select Trigger On This.
This action performs several tasks:

B Places the density measurement box at the click point

B Sets the measurement box to its default size

B Measures the average density in the box

m  Sets the Trigger mode to Triggered

B Selects the DPX Density "Higher" trigger type

m  Adjusts the trigger threshold to a density value slightly below the current measured value
®  Starts the acquisition process

To optimize DPX Density trigger settings for your particular signals, open the Trigger control panel. Use the controls for
changing the polarity of the trigger’s threshold comparison (Higher versus Lower), the Threshold value, and the size and
location of the measurement box. Use the Frequency and Amplitude settings to locate the center of the box, and set the +/-
values to adjust the width and height of the measurement box.

For events that are partially masked by stronger signals, you will often need to adjust the density Threshold based on
density measurements of the event of interest and of the obscuring signal. For example, if the density of the background
color representing only the stronger signal is 7% and the density measurement including both signals is 9%, you would
set the Threshold to 8%.

7\ Tek RSA6100A - [DPX Spectrum]

Bl Fle wen Run Markes Setup  Tools  Window  Help -8 %
[DI5D|EVE| [MBrkels”Settlngs] Trig || Acg || Ana | & Freq: 2.05119 GHz % RefLev: 0.00 dBm
L “ Bitmap [?]Show File:sweepand pulse.

&' -15.51 dBm
= dB/div:
10.0 dB
o RBW:
300 kHz

-115.51 dBm

& CF: 2.05119 GHz © Span: 40.00 MHz

If your expected signal is a continuous tone and you want to capture events when it hops to a different frequency or drops
to a lower amplitude, move the Density measurement box to surround the peak of the signal, select Lower in the Density
control, and set Threshold to 100%. The instrument will trigger when the signal is absent from the measurement box.

Hint. The density measurement is the average of the densities for each column of pixels in the box. If your measurement
box is wider than the peak of a CW signal, the density reading will be less than 100%. To get a 100% reading, you can
broaden the peak by increasing RBW or narrow the box until there are no colored pixels either above or below the box. The
signal should enter the left side of the box and exit the right side. It should not cross the bottom edge of the box.
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Creating a Frequency Mask

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

You can create a Frequency Mask by using either the manual or Auto Draw method. The following procedure explains the
manual method. For a procedure on how to use the Auto Draw method, see the topic Mask Editor (Frequency Mask

Trigger) in the online help.

1. Click Trig to open the Trigger control
panel.

Select the Event tab in the control panel.
Set the Source to RF Input.
Set the Type to Frequency Mask.

o &~ o b

Click Mask Editor to open the Mask
Editor.

The Mask Editor opens with the traces of
the Spectrum display in the graph.

6. Click New in the tool bar. This removes

the existing mask and then creates a
default 6-point mask.

44
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[\ Tek RSA610DA - [Spectrum]

[BEE

Fie Wiew Run Markers Setup Tools Window  Help

- 8 X

= ReflLey: -50.00 dBm &pla
1909043

@
@0 @

®

Trigger Event | @ Tim¢| Quaified | Advanced |
Source: ”
@ Free Run oT OT>F OT>F>T [7Mask Ediror
RF Input -
O Triggered . OFT OFTF Load from file
ype:

Frequency Mask &

Mayx Editor - Mask1
File

OF
P rdee

RBW: [300k0z | [ Auto

1909047

B

Save As...l l Done

Reference: |Spectrum Trace 1 v

(to be in list, a trace must be showing in a display)

TR O Add points o .
graph to: @
(& Edit Points
0.00 dBm

it

-100.00 dBm|

CF: 1.500 GHz Span: 40.00 MHz

X Margin:| 5.000 MHz

¥ Margin: 10.000 dB

Offset Freq Amplitude
-19.990 MHz -30.00 dBm
-8.000 MHz -30.00 dBm
4.000 MHz -10.00 dBm
4.000 MHz -10.00 dBm
8.000 MHz -30.00 dBm
19.990 MHz -30.00 dBm

1903048
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7. Click any point in the mask to select it.
The frequency and amplitude of the
selected point are highlighted in the
graph.

8. Edit the point by doing one of the
following:

®  Drag and drop the point with the
mouse.

B Enter the frequency and amplitude
in the table.

®  Adjust amplitude with the up/down
arrow keys and frequency with the
left/right arrow keys.

Quick Tips

Mask Editor - Mask1

File

Operation

EEX

Reference: 5pecr|urn Trace 1 v

& Edit Points

0.00 dBm

1 . o I|‘l’|‘i'|'1|\

CF: 1.500 GHz

New ] [ QOpen I Save Save As... | I Done

(to be in list, a trace must be showing in a dlsp\av)
Cickin O Add points X Margin:|5.000 MHz
graph to: prt * -

¥ Margin:| 10.000 dB

Olfset Freq Amplitude
‘ il -194990 MHz -30.00 dBm |
H|| U '\' 8560 MHz -30.00 dBm \
4.000 MHz -10.00 dBm |
4.000 MHz -10.00 dBm \
8.000 MHz -30.00 dBm |
|

19.990 MHz -30.00 dBm

Span: 40.00 MHz

1909049

m  Click Auto draw to generate a mask automatically adjusted to the Reference.

B Right click on the display screen to add a new point.

= Click Add Points and then click on the graph to add a new point in the graph.

= Click Next to select the next point in the graph.

m  Click the X (delete button) to delete the selected mask point.

m  Click Save to save the mask file and continue working with the mask editor.

= Click Open to load and edit a previously saved mask file.

Defining Trigger Conditions

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.

The choices are described in the
following table. (See Table 7.) The icons
at the bottom of the control panel identify
what is considered true or false.

2. Click Triggered.

The instrument will trigger when the
trigger conditions are met.
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‘ Violaton
Source:
©Free Run — | ot OTF  OT=FT Mask Editor
RF Input -
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O Triggered % O Load from file

Type:
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Table 7: Trigger violations

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no violation)
after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after being
outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask, cross

outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask (no
violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when you analyze recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a [ Tek RSA6100 BEE
Spectrum dISplay and a DPX Spectrum Fle  ¥iew Run  Markers  Setup  Teols  Window  Help
display. The highlighted title bar on the DPX ~ [see] (e Joeim [ [ lva ] = ewsotonasc et s000

Eu:la Wsoeciinn BED
e * Trace 1 Show  +Peak Normal

‘l'\
T y hh[w u ‘”

Spectrum display indicates that it is the

7 Bitmap  [MShow  oOn

selected dlsplay o sno0cen [N = 50,00 dem [N
The check mark indicator in the upper e ) “hee

left corner of the display indicates that e ‘1 S
acquisition hardware is optimized for the | 1

Spectrum display.

14 |” “

[’

i
-110.00 dBm il i o | -is0.00dBm

Autoscale el : 0. Autoscale Z CF: 91.49 MHz & Span: 9.67 MHz
Markers v MR |Frequency v [91.485487 Mz (e ] (¢] *] =) [x]
4nalyzing Acg BY: 10,00 MHz, Acq Length: 89,120 us Real Time  Free Run Ref: Int  Atten: 10 dB Preamp

1909025

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The RSA6100A Series Real-Time Spectrum Analyzer lets you open any combination of measurements. You can select

the displays that you are interested in and the instrument will automatically set up the appropriate analysis and acquisition
parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front
panel to set the instrument to the default
settings.
Cl Cl

your signal and then set the span.

Touch Screen
2. Tune the instrument to the frequency of off J J @

1909-016

3. Click Displays to open the Select L Tek RSA6100  [Spectrum] REE

DiSplayS dlalog bOX file  Wiew Run  Markers Setup  Tools tindow  Help -
l Displays | | Markers ||Settings || Trig || Acg || Ana | © Freq: 91.49 MHz < Refley: -50.00 dBm
R

1909056

4, Select the General Signal Viewing folder. 1 Select Displays WES

5. Select the Amplitude vs Time icon.

Application Preset. Application Presets...

Choose a Ination below, {

6. Click Add to add the icon to the Selected Folders: e
DiSplayS ||St General Signal Viewing 1

AMPL | o]
Analog Modulztion Vo fL oy —
Amplitude vs DFX Frequency  Phase vs
Time Spectrum vs Time Time

RF I&Q vs Spectrogram Time
Time Overview

GP Digital Modulation

NOTE. Add the Spectrum display if it is not RF Vzzsurements
already in the Selected Displays list.

7. Click OK to accept the changes and
close the dialog box.

Selected displays:

acd
Spectrum
0K I l Cancel l
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Operation

8. Click Run to start acquiring data.

9. Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

10. Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,”

all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

11. Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn’t contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.
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)\ Tek RSAG100A o [NEE
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v Trace 1 [Fshow  Normal
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.I @ 1009052
7\ Tek RSA6100A =)
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IDlsp\ays M Settings mﬁ Freq: 1.9570 GHz “ RefLev: 0.00 dBm | Run
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e w Tracel [¥lshow  Noma “ Tracel [FlShow  +Peak Mormal Clear
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< dBfdiv: © dBydiv:
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,ﬁ ~| Wi | |p\|l\ W\
T |‘ \ J
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12. Decrease the span to 40 MHz in the
Spectrum display. Now the acquisitions
are real-time again.

13. Check the status bar readout to verify
that the acquisition is real-time.

Both of the displays can run now.

RSA6100A Series Quick Start User Manual
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& defdiv:
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T
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~ Reflev: 0.00 dBm

0 Spectnlm |

< 0.00 dBm

o de/div:
10.0 dB

& RBW
300 Kz

-100.00 dBm

Autoscale

# Trace1 [“Show  +Pesk Normal

,?‘.

¢ CF: 1,99700 GHz

Clear

'\
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Searching Signals

The RSA6100A Real-Time Spectrum Analyzer lets you search signals for changes in power level. You can identify matches
as crossing a power level or you can create a mask that specifies power level and frequency range limits. You can select
which trace to search and specify an action to take when a search match occurs.

To search a trace:

1. Open the Spectrum display or select the
Spectrum display if it is already open.

2. Select Tools > Search.

3. Select the Enable Search check box.

4. Select the trace you wish to search from
the Search in drop-down list box.

5. Verify that the trace you selected in the
Search in list is the selected trace and
that the Show box is checked.
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Search for: |is greater than

©)

L Tek RSA6100A - [Spactrum] =3
Fle View Run  Markers  Setup  Tools  Window  Help [-]® =
Displays | [ Markers |[settings][ Trig |[ Acq |[ 4na | @ Freq: 9.30047 GHz S Reflev: 0.00 dBm EF
< “ Trace 1 [¥IShow  +Peak Normal Clear
¢ 0.00 dBm
< dg/div:

10.0 dB

S REW
1 MHz
-100.00 dBm
% CF:9.30047 GHz % Span: 40.00 MHz
Search Define | Actions

'
Enable
DSear[h Search in: |Spectrum: Trace 1 ~

hd -20.00 dBm

I Tek RSA6100A
Fle Vew Run

1908134

Markers  Setup  Tools  Window  Help =X
Displays | [Markers ][ |ettngs][ Trig | Aca J[anz | @ Freq: 9.30047 GHz S Reflev: 0.00 dBm

< # Trace 1 [4]Show

+Peak Normal

< 0.00 dBm

< de/div:
10.0dB

S RBW
1 MHz

-100.00 dBm
Autoscale

Search

Enable
Search

& CF: 9.30047 GHz

Define | Actions

Search in:

Search for:

Spectrum: Trace 1

Spectrum: Math Trace
Spectrum: Spectrogram Tjace

Y Span:40.00 MHz

-20.00 dBm
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Operation

6. Speciy whatto search for by making 2

selection from the seal’ch fOI' drop-down Bl Fie Vew R Markers Setp Tools Window Help 5 x

||st @ays\ Markers |[settings][ Tria |[Aca |[(ana | = Freq: 9.30047 GHz = RefLev: 0.00 dBm
. v ¥ Trace 1 [YIshow +Peak Normal r

To search for signal levels above or = 0.00 cam

below a specified level, select either is sy

greater than or is less than. e

To search for signal levels that vary with
frequency, select either is outside mask
or is inside mask. To specify the limits

in the search mask, click the Edit limits

-100.00 dBm
bUtton' & CF: 9.30047 GHz & Span:40.00 MHz
The orange shaded area in t.he glraph Searth Dot |t
display shows the levels which, if ’
. . . . Enable
occupied by the signal, will constitute a Bl searcn search in:|Spectrum: Tracs 1 =
match. Search for: |is greater than v 20.00 d8m

is greater than k
is less than
is outside mask
inside mask
@ 1908121

Display with greater than search selected

. Tek RSA100A - [Spectrum] =3
Fle View Run Markes Setp  Took  Window  Hel -
Displays | [ Markers |[settings][ Trig |[ Acq | ane | ¢ Freq: 9.30047 GHz % RefLev: 0.00 dBm Run
< “ Trace 1 [¥IShow  +Peak Normal Clear
¢ 0.00 dBm
< dg/div:
10.0 d8
S REW
1 MHz
-100.00 dBm
% CF:9.30047 GHz % Span: 40.00 MHz
Search Define | Actions
‘
Enable
Sear[h Search in: |Spectrum: Trace 1 ~
N sl o 3

1909137

Display with outside mask search selected
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7. Click the Actions tab to specify what
actions the spectrum analyzer should
take when a match occurs.

The spectrum analyzer can take up

to five actions when a match occurs,
depending on the run mode. In Run
mode, the spectrum analyzer can
sound a beep, stop acquisitions, save
acquisition data, save trace data, and
save a picture of the display. In Replay
mode, it can sound a beep and stop
analyzing.

8. To have the spectrum analyzer take an
action when a match occurs, select the
desired action.

You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

9. Click the close box to remove the Search
control panel.

10. Press the Run button to initiate a search.

Red lines appear in the graph display
when there is a match on incoming data.
Click the Replay button on the toolbar
to initiate a search on the current data
record.
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Using Correction Tables

The RSA6100A Real-Time Spectrum Analyzer lets you correct the signal displays and measurement results to account

Operation

for gains and losses in external equipment. You can specify a single gain value or you can use an external loss table to

adjust the gain/loss value based on frequency.

To specify external gain/loss corrections:

1. Press the Ampl button to display the
Amplitude control panel.

2. Select the External Gain/Loss Correction
tab.

3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box.

NOTE. You can enter either positive or
negative gain values. Positive values
represent a gain. Negative values represent
a loss.

4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables.

You can enable all three external loss
tables at the same time. Thus, you could
use different external loss tables for an
antenna, a preamplifier, and for cabling.

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.

RSA6100A Series Quick Start User Manual
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Amplitude Intamnal Settings | External Gan/Loss Correction | Extamal Probe Correction
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Apply table corrections to:
© All acquired data (filter method) ] Edit...
. Traces in Spectrum, Spectrogram, Spurious
®
*~ and Amplvs-Time o Edit...
1909130
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“ i : o8 Extemnal Loss Tables (Loss = 0, Gain < 0)
V| External Gain value: |0.0 d
o
Apply table corrections to:
(O All acquired data (filter method) o
,;(ITrates in Spectrum, Spectrogram, Spurious =
© and Ampl-vs-Time o
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6. Edit the contents gf .the table to match T T
the loss characteristics of the equipment
i i . X: Freq Y: Loss (At
you are qo_rrectmg for. Click OK when X Frequency : Loss (Atten)
you are finished. 5.500000 GHz -1.023000 dB

NOTE. You can enter either positive or e Fi o
negative values into the table. But in contrast
to the External Gain value setting, positive

values represent a loss and negative values O e Covectiom
represent a gain.

@ Linear

For detailed information on using the Table
Editor, select Help > User Manual and look

in the Index for External Loss Tables. |uew Tah‘e] [ Ll ] S | [ e ] [ ok ‘ l Cancel
1909151
7. You can change the title for each external R o e
loss table. Select the title box and type Fie Vien Run Makers  Sewm  Took  Windon  Hel - B x
in a new t|t|e Warkers |[settngs|[ Trig || Acq [ Anz | @ Freq: 9.30047 GHz < ReflLev: 0.00 dBm
. . . o % Trace 1 [“Show +Peak Normal @
Note that the title is only a label. It is © 0.00 dam
not tied to the file name of any table you oo
have loaded or saved. o

8. Specify whether table corrections are
applied to all acquired data or only to
traces in the Spectrum, Spectrogram,
Spurious and Amplitude vs Time

-100.00 dBm

dlSp'ayS. = CF: 9.30047 GHz © Span:40.00 MHz
Amplitude Internal Settings | External Gain/Loss Correction | External Probe Carraction
o ‘ ‘ iR External Loss Tables (Lass = 0, Gain < 0)
External Gain value: |0
Antenna
Apply table comrections to:

© all acquired data (filter method) Preama

ol Traces in Spectrum, Spectrogram, Spurious T

* and Ampl-vs-Time Cabing

@ -
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When choosing whether to correct
sample data or traces, keep the following
in mind:

B |f sample data is acquired while
data correction is enabled, that data
record is permanently corrected. If the
acquisition is saved and recalled, the
recalled acquisition includes corrections.
Corrections are not saved separately
from the raw data; they are used during
the acquisition process to adjust the data
values.

m  Trace corrections can be applied
at any time, as they are part of the
measurement’s computations. Using
Replay will apply trace corrections to
a trace if this control is enabled (and
an external loss table is specified and
enabled).

B Be aware that if you recall acquisition
data that was saved with data corrections
and you use Replay with trace
corrections selected and an external
loss table enabled, the trace will be
calculated using corrected data and also
corrected with trace corrections. This
usually creates incorrect traces.

9. Click the close box to remove the

Amplitude control panel when you are
finished making changes.
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Using Audio Demodulation

The RSA6100A Real-Time Spectrum Analyzer can demodulate audio signals which can help you to identify unknown radio
signals. You access the Audio Demod tab from the Settings control panel of the DPX Spectrum display.

To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX Spectrum display will open.

5. Press the Settings front-panel button
to display the DPX Spectrum Settings
control panel.

6. Click the Audio Demod tab to display
the Audio Demod control panel.
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7. Click the On button to enable audio
demodulation.

i . . DPX Spectrum | Freq & Spin | BW | Traces|| Scale | Prefs | Density | Audio Demod
8. To specify the demodulation type, click Settings
. Tune with: | Selected Marker %
either the AM or FM button. o Audio Receiver Freq:  91.5 MHz
Gain*
NOTE. Note that the AM and FM buttons > ° Receiver gwi; |0.000 K52
select only the demodulation type; they do « Sound el 1 o affctsd by Windows ol oo
not specify a frequency band. e
9. Set the center frequency as needed.
The receiver frequency (frequency to DX Spectrum | Freq & Span 81| Traces | Scae | Prefs | pensty Audio Damod
be demodulated) is specified with either * e vover B
markers or the frequency control (the o | S E—
Gain® I i
front panel Frequency button or the Freq iR —
control in the toolbar). Use the Tune with T
setting to specify whether markers or the oo 29
frequency control is used to specify the
receiver frequency.

10. Select either a marker or frequency
control from the Tune with drop-down
list.

11. If the marker you select is not enabled 51, Tek RSAG100 - [DPX Spectrum] BEE
- 8 x

(lt W|” be V|S|b|e m the d|3p|ay If |t |S File Wiew Run  Markers  Setup  Tooks  Window  Help
enabled) CIICk the Mal’kers bUttOI’] |n the Samngs % Freq: 91.500 MHz ~ ReflLev: 0.00 dBm Run |
’
. g v +Pezk Tt [Jshaw  Off -Clear
toolbar to display the Markers toolbar. A
< defdiv:
7.00 dB
© RBW
254z
-107 .50 dBm Y
Autoscale = CF: 91,500 MHz & Span: 2,500 MHz
SD:t)t(iﬁ'g]:Ctmm Freq & Span | BW | Traces | Scale | Prefs | Density | Audio Demod
Tune with: | Marker MR -
on
- Audio Receiver Freq:  88.5 MHz
Off 30.000 kHz
oS Receiver BW: 300
Restore
* Sound level is also affected by Windows volume control.
Analyzing Acg BW: 2,50 MHz, Acg Length: 222,720 us Red Time  Free Run Ref Int  Atten: 25 dB Preamp
1990-138
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12. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

13. Click Add to add markers as needed.

14. Click the Settings button to return to the
Audio Demod control panel.

15. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.
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16. Set the receiver frequency.

If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. Fine tune the marker
position with the front-panel knob or
your mouse wheel. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.

The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

17. Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.
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optional, 2
power cords, 2
standard, 1

Acquisition
conflicts, 47
controlling, 46
data source, 22
starting, 30
stopping, 30

Analysis window, 21, 23

Application presets, 25

audio demodulation, 56

C

CF Pan

Touchscreen actions menu, 34
check mark indicator, 19, 46
Cleaning procedures, 11
Conflicts

measurement, 47
Connectors

front panel, 16

rear panel, 17

RF signal input, 29, 30
Controlling acquisitions, 46
Controls

display-specific, 20

front panel, 13

interface, 18
Cooling clearances, 3
correction tables, 53

D

Data

recalling, 39

saving, 38
Default settings, 28
Diagnostics, 10
Digital demodulation displays, 23
Display

conflicts, 47
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Display properties
changing, 9
Display settings
changing, 27
Displays
general signal viewing, 23
GP digital modulation, 23
printing, 36
Pulsed RF, 23
RF measurement, 23
selecting, 24
Documentation, viii
Tektronix part numbers, 1

E

Environmental specifications, 3
altitude, 3
cooling clearances, 3
humidity, 3
temperature, 3
Extended desktop, 6
external gain/loss correction, 53
External monitor, 6

F

Features, viii
File types, 38
Free Run trigger mode, 40
Frequency mask
Mask Editor, 44
triggering, 40
Front panel
connectors, 16
controls, 13

G

General signal viewing displays, 23
Graphics driver, 9

Incoming inspection, 10
Information messages, 26
Ink saver mode, 36

Input requirements
frequency range, 29
input impedance, 29
power, 29
RF signal range, 29
voltage, 29

Installation, 1
network connections, 4

Italicized numbers, 20

K

Key features, viii

Maintenance
cleaning procedures, 11
repackaging, 11
Marker toolbar, 33
Markers, 31
absolute, 32
adding, 33
defining, 34
delta, 32
DPX bitmap trace, 32
shapes, 32
Mask Editor
adding points, 44
editing points, 45

Measurement

conflicts, 47
Mechanical specifications, 3
Messages

on-screen, 26
MR, 32

N

Network connections, 4

0]

Optional accessories, 2
Options, 3
Power cords, 2

Index
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Index

P

Pan

Touchscreen actions menu, 34
Part numbers, manuals, 1
Power cord options, 2
Power level triggering, 40
Power supply, 3
Preset, 28

selecting displays, 25

system settings, 28
Printing, 36

ink saver mode, 36
Product features, viii
Pulsed RF displays, 23

R

Real-Time spectrum analyzer, 21
Rear panel connectors, 17
Recalling data, 39
Repackaging, 11
Reset scale

Touchscreen actions menu, 34
Returning the instrument, 11
RF measurement displays, 23
RF signal connections, 29, 30
RF signal input range, 29
Run control, 30
Run menu, 30

S

Safety Summary, iii
Save options, 38
Saving data, 38
Screens, printing, 36
Search, 50
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Select
Touchscreen actions menu, 34
Selected window, 46
Selecting displays, 24
Settings
changing, 27
default, 28
preset, 28
Setups
recalling, 39
saving, 38
Software upgrades, ix
installing, 11
Span Zoom
Touchscreen actions menu, 34
Specifications
altitude, 3
cooling clearances, 3
environmental, 3
humidity, 3
input requirements, 29
mechanical, 3
power supply, 3
product dimensions, 3
temperature, 3
Spectrum analyzer
real-time concepts, 21
Standard accessories, 1
documents, 1
power cord, 2
Starting acquisitions, 30
Stopping acquisitions, 30

.

touchscreen actions menu, 34
Trace legend, 27

Trigger
control panel, 42
mask, 44
violations, 46
Trigger Event parameters, 41
accessing, 42
Triggered trigger mode, 40
Triggering
free run, 40
frequency mask, 40
parameters, 41
power level, 40
triggered, 40

U

Upgrades
software, ix, 11

vV

Violations
trigger mask, 46

W

Window
analysis, 21
selected, 46

Z

Zoom
Touchscreen actions menu, 34
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